With ecm:one into the cloud

Incoming invoice processing
workflow

Stand: 21.06.2022



&) ecm:one:

Welcome

Welcome to our document management system d.velop documents. For a perfect start, this manual
explains all essential functions, workflows and ShortCuts - so nothing stands in the way of a perfect
start in the digital DMS.

Your ecm:one
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Processing of incoming invoices — tasks, tips & tricks




€ ecm:one:
ecm:one Xtractor

Incoming invoice processing can be accessed via the "ecm:one Xtractor" tile. On the start screen, you can see the
incoming invoice as well as switch between the different clients.

Switch between - :
clients with a click HEQ@:

. . c _
T (if available). DEEE @ecm ones
_ > Document recognition |~ Recognation statistics «S Workflow-Dashboard

Valid e-mail adresses -
[fe)

12021_2h6_invoices_1716@xtractor.ecmone.cloud ‘
Not imported files

sender receiver subject date actions Filename

“ ecm:one Xtr@ctor - Dashboard

e

The help page is
available for
questions about
operation. An
total: 0 operating
manual provides

_ 2nd import option: Drag'N'Drop support for

The import of the documents stored here quick questions.
takes place automatically every 2 minutes or
can be triggered manually.

E-Mails not processed

There are no emails All files have been processed. Excellentl

total: 0

\

Import by e-mail is carried out via the e-mail
address assigned here.




ecm:one Xtractor

You will find the batches under the item

recognition opens.

€ ecm:one:

Document recognition. These can be opened via the ID and the document

“ ecm:one Xtr@ctor - Dashboard

Stacks to be processed:

# open stacks 6 | # documents 10 | # pages 16
id name

1632433 Invoices_Mail_12021_2h6_16.08 2023_14:3¢
1632438 Invoices_File_12021_2h6_16.08.2023_14:37
1734791 Invoices_File_12021_2h6_0809.2023_09'16
1830410 Invoices_File_12021_2h6_02 10.2023_21:32
1977073 Invoices_File_12021_2h6_03.11.2023_11:44
1978552 Invoices_File_12021_2h6_03 11.2023_14:33

T

& Incoming documents _ |~ Recognation statistics =5 Workflow-Dashboard

creation date

16.08.2023 14:36:45

16.08.2023 14:37:22

08.09.2023 09:16:38

02.10.2023 21:32:59

03.11.2023 11:44:25

03.11.2023 14:33:13

BiEEIE

queue editor comment # document # pages
Verify Diverser/ 1 2
Verify Diverser/ 1 4
Verify 5 5
Verify Diverser/ 1 1
Verify ABUSPfaf/ 1 2
Verify ABUSPfaf/ 1 2

T

HE0®:

@ ecm:one:

actions

s

Batch ID: Click to open the
document ID. If these are
grayed out or have a lock symbol
in front of them, this batch is
currently not accessible for
editing. The batch is either in the
Analysis, Export step or is
currently being processed.

3 different queue statuses:

- Analysis: Document recognition is performed, no processing possible

- Verify: Document recognition can be opened via ID

- Export: Document recognition has been carried out, batch is sent to the
workflow and d.velop documents; disappears from this list shortly afterwards




Webverify

ecm:ones

Webverify opens by clicking on the ID of the batch. This is where the document recognition takes place.

Mal W= N e W R
AIN MEN SN . é [l’ ':l t\ Company Code Mail from
Mandantenname wurde nicht auf |
I i Beleg gefunden - bitte prafen. Name of vendor
Bilirwices e Ld)_chis ABUS | Pfaffennain GmbH | 70065 | i
1978553 abus.com
Security Tech Germany Cou-ame ZIE: Eity _VAT Reg No
E m _ IDEMIZQSO]OI
h Docume... Invoice number Invoice date Service Date
ABUS Pfaffenhain GmbH - FabrikstraBe 1 - 09387 Jahnsdorf RECHRINg ‘ Rechmmg‘ ‘ 3789456 ‘ | 06.09.23
Nr. 3789456
Ner‘kzeuge & mehrl Datum ©06.09.2023 Net amount 1 Vat amoun... Vatrat... Net amount 2 Vat amoun... Vatrat...
Gewerbegebiet 1 Seite: 1 von 2 ‘ 3z,o7| | s,m| [ 19,00‘ ‘ l ‘ ‘ ‘
48167 Miinster Kunden-Nr.123456789
Net amount 3 Vat amoun... Vatrat... Gross amount Currency
| | | [ 38,17' IEUR
Zahlungsbed. 14_Tage 4% Skonto, 30 Tage netto yment'rype Disc. 1%  Due date IBAN on document
Uber sun: [ 4,00‘ ‘ 17.09.23 ‘ ‘ DE90450400420356668400 I

Indexnr: H23573/36 Bestellung: 1000013

Anlagenart: Cod. EinzelschlieBung:1WP Hermann Hofmann

Angebot: Kommission: 06.09.2023 System:
Versandart: UPS 2

vom:_06.09.2023

Pos Artikel-Nr. Menge ME VPEPreis/st. Rabatt Netto/St. Gesamt
EUR

EUR

1 ziLa30 1 st. 26,99 26,99

Profilknaufzylinder 1st. 18,99 18,99

Z01it.1000 6-stift.

AchsmaR (auBen/innen):60,5/40,5 mm 8 st. 1,00 8,00

Knauf innen:STD-ZANP-Form Z

Zylinderprofil:ZT26C Schliisselprofil:ZT26C

Schlisselprigung:PF-37_PF-4 ABUS Zolit_blank

Schlisselanzahl:3

Schachtel:Schmuck blau ABUS

Zylinderprigung:ABUS SKG 3 Sterne

Zertifikat:SKG 3 Sterne

Kupplung:Gefahrenfunktion

Bohrschutz:erhdhter Bohrschutz

Zwischensumme

Bitte beachten Sie, dass wir nicht lber Einkaufsverbdnde abrechnen!
Beziiglich der sp&ateren moéglichen Entgeltminderung verweisen wir auf
unsere aktuellen Zahlungs- und Konditionsvereinbarungen zwischen

unseren Unternehmen. Unberechtigt abgezogener Skonto wird nachberechnet.
Der Lieferzeitpunkt entspricht dem Monat des Rechnungsdatums.

I

Structure of the invoices in the stack;
the structure shows where the first
page of a new invoice starts. The
icons at the top of the stack show the
status.

View of the invoice / the current page.
Bar above offers visual adjustment
options (larger/smaller, adjust invoice to
width/height, display recognized text,
switch on color)

GL Account

‘ 23 # Werkstatt ## Betragsgleiche Buchung (L700003811) ]

Systeme

Document recognition data. Color markings indicate field status.
Gray/white: Detection OK, no confirmation necessary

Green: Recognition good, confirmation required

Red: Recognition incorrect, confirmation/correction required




‘VVebverﬁy

CompanyName Company Code Mail from
-'P[ ecm:one Testl 12021_2h6
Mandantenname wurde nicht auf

VBeleg gefunden - bitte prufen. Name of vendor

70065 ABUS Pfaffenhaun CmbH

Cou... ZIP City VAT Reg No

DE 08387 Jahnsdorf DE141295010

Docume... Invoice number Invoice date Service Date

Rechnung 3789456 06.09.23

Net amount 1 Vatamoun...  Vatrat.. Net amount 2 Vat amoun...  Vatrat..

32,07 6,10 19,00

Met amount 3 Vatamoun... Vatrat... Gross amount Currency
38,17 EUR

PaymentType Disc. 1% Due date IBAN on document

Uberweisung 4,00 17.09.23 DES0450400420356668400

GL Account
4985 # Werkzeuge und Kleingerate ## Betragsgleiche Buchung (L700003811)

Kostenstelle
23 # Werkstatt ## Betragsgleiche Buchung (L700003811)
Kostentrager Systeme

AccountingText

Dactylogram

&) ecm:one:

Client information: Selection by deleting a letter and selecting the correct client.
Mail from shows the sender for mail import.

Supplier information: Access to the client-specific supplier master data. Selection by
entering the name or supplier no. Tip: If the error message "Not compatible with
company code" appears, the selected supplier does not exist in the client master data!

Invoice information: Selection possible on the receipt by clicking on the corresponding
number/date/amount. Payment information is calculated automatically, if there are
discrepancies the amounts do not match. Payment method: Choice between "Bank
transfer", "Direct debit", "Other payment method"; in the case of "Bank transfer"”, the
invoice is offered later for transfer. Split: possible here between 2 items, larger split entry
possible on second page (nhext slide). IBAN: Selection by clicking the space bar, all IBANs
found are suggested.

Account assignment: Proposal of historically known G/L accounts; selection also
possible by entering the G/L account number or name. Posting text can be entered or by
holding the Shift + mouse pointer key = drag box around area. Hold the Ctrl key to select
text in different places on the document.




€ ecm:one:

Webverify

Execute split booking

MAIN MENU

[2 Invoices_File_12021_2h6|

Secunty Tech Germany.
Rechnung

Nr. 3788456
Werkzeuge & mehr! Datum 04.09.20823
Gewerbegebiet 1 Seite: 1 von 2
48167 Minster Kunden-Nr.123456789

Zahlungsbed. 14 _Tage 4% Skonto, 39 Tage_nett

Indexnr: H23573/36 Bestellung: 1600013

Anlagenart: Cod. EinzelschlieBung:1WP Hermann Hofmann

Angebot : Kommission: 94.09.2023 System:
Versandart: ups 2

vom:_04.09.2023

Pos Artikel-Nr. Menge ME VPEPreis/st.
EUR_

1 21430 1st.
profilknaufzylinder 15t 18,98
2014t.1000 6-5tift.

Achsmal (auBen/innen):60,5/48,5 nn 85t 1,08
Knauf innen:STO-ZANP-Form 2

Zylinderprofil:ZT26¢ Schlisselprofil:ZT26¢
Schlisselprigung:PF-37_PF-4 ABUS Zolit_blank

schlgsselanzahl:3

Schachtel:Schauck blau ABUS

Zylinderprigung: ABUS SKG 3 Sterne

Zertifikat:skG 3 Sterne

Kupplung :Gefahrenfunkt fon

Bohrschutzierhghter Bohrschutz

Select split bookings

2Zwischensusme

Bitte beachten Sie, dass wir nicht iber Einkaufsverbiande abrechnen!
Beziiglich der spdteren moglichen Entgeltminderung verweisen wir auf
unsere aktuellen Zahlungs- und Konditionsvereinbarungen zwischen

unseren Unternehmen. Un| =re:htidgt abgezogener Skonto wird nachberechnet.
Der Lieferzeitpunkt entspricht dem Monat des Rechnungsdatums.

Total amount ‘ TaxCode ‘ G/L account ‘ Article text Kostenstelle Kostentrager Systeme Projekt

[ 32.07] 4985 # Werkzeuge und Kleingerdte 23 # Werkstatt #% Betragsgleiche Buchung (/

Pl
Single lines for entering the account
assignment information. Helpful
shortcuts on the next page.




Webverify

Shortcuts for split booking

Shortcuts for Xtractor:

F9: Recognition of the positions in the next lines

F8: Copy and paste the field contents

Alt + I: Adding an account assignment row (summarizes the balance)

Alt + E: Add a table row (Without amount)

Alt + D: Delete a line

CTRL + Alt + K: Change account assignment type; choice between simple account
assignment or account assignment with items

Reanalyze batch: STRG + F10

Cancel batch, save + leave comment STRG + E

Continue to the next field to be confirmed Plus key

Delete account assignment table + net amount Alt + T

Show account assignment table for split posting (then add rows Alt+l) STRG + Q
Field training / Record dactylogram F12

Calculate total amount ALT + C

@& ecm:ones:



Webverify

Workflowuser

The reviewer and approver can be selected from the list by clicking in the
corresponding field and pressing the space bar.

In addition, a specific reviewer/approver is suggested from the historical
logsapprover is suggested from the historical logs (indicated by the
workflow log and the number how often this user has already been
selected for this supplier

After editing these fields, click Enter in the Export_Colour field and
confirm Send.

Explanation on the
next page

Cheacker

-‘{ BN: Pia Stroot # GR: # WFL-Protokoll Anz.:1

Approver
BN: Daniela Odinius # WFL-Protokoll Anz.:13

Workflow?

[ warkflow_stanen

[0 guchungsdaten_generisren
D nur_ablage

O poF_Expont

[CIwarensrechnungserkennung

WFL_Kommentar

Select Workflow

&) ecm:one:

10



Worlkflow?
Workflow_starten

|:| Buchungsdaten_generieran
|:| Nur_Ablage

I:' POF_Export

| lwaren rechnungserkennung

WFL_Kommentar

Several hooks can be combined!

Workflow_start:
Workflow required, select reviewer and
approver

Generate_posting_data: If the invoice
has already been assigned to an account,
the posting data can be created directly.
This is also possible at any time later
from the search.

File_only: Audit-proof archiving in the
DMS without workflow

PDF_Export:
Download the file as PDF with backup to
FileShare.

Commercial Innvoice :

A batch is created in the ecm:one
document recognition items after the
export.
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Webverify

Tastenkurzel im Verify

Zoom on the document Mouse wheel scrolling

Movement on zoomed document Hold down the left mouse button, move the mouse

Selection on receipt Shift + box drag with left mouse button

Next field Tab

Previous field Shift + Tab

Line up/down Arrow up/down

Line Left/Right Line Left/Right

Confirmation of a field Enter

Displaying the selection options Space bar + down arrow = Display and select the
selection list

Selection of a word/date Mouse click on word/date

Displaying a duplicate Strg + D

12
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Webverify

Training options

Supplier training (dactylogram)

Please use with caution!
1. Select the supplier in the 'Supplier no.' field from the drop-down list.
2. Press the F12 key and confirm the start of the training (dactylogram)
3. Press and hold CTRL + Shift and draw a box on the document with the left mouse pointer, based on which the supplier is to be recognized in the future
NOTE:
a. Minimum of 200 characters in the box
b. Box must ALWAYS be there
= The imprint field at the end of an invoice is therefore a good place to enter the name, address, payment information, etc.

4.  Press F12 again
5.  Confirm training

The training has now been completed. In future, this supplier will be selected on a client-specific basis based on the trained parameters (can be seen in the
dactylogram field)

Possible causes of error:

o The supplier is not stored in the master data. Then no training can be carried out. Therefore, first create the supplier in the master data and carry out
training again
o Dactylogram not started in the 'Supplier no.' field. Make sure that you have clicked in the field before you start the training.

Other fields such as due date, invoice no. or payment type (field training)
If these are always in the same place in the document, this can be trained.

Draw the box around the corresponding field on the document: Shift + press the left mouse pointer
Content is transferred to field

Press F12 - Dialogue about successful training opens

Close dialog window

il NS

13



Webverify

Training options

Delete a training:

The training is stored in the so-called dactylogram and in field trainings. If at some point these
are no longer up to date (e.g., because the supplier uses a new document layout) or it was
carried out incorrectly, these can be deleted.

1. Open main menu in the upper left corner

2. Opening the menu structure: Extras = Training 2>

3. Here you can now delete the field training as well as the dactylogram

4. Renewed implementation of the trainings is now possible

Tip:

Vendor master data is automatically maintained when an invoice is processed for the first time.

If information such as the VAT number or IBAN is missing, it is automatically entered in the
master data after the

automatically entered in the master data after initial selection.

The advantage: The master data improves, and the recognition becomes better from invoice to
invoice!

File »

Edit »
Document »
Separation »

Navigation »

View »

Extras »

Clearing »
Tabellenfunktionen »

Help »

Functions »
Workflow »
Training »
Clearing »
Finishing »

Stapel an Cutter
schicken

Kontierungsart andern

Zeige fehlerhafte
Felder

Dublette vorhanden

Bestellung offnen

EMail offnen

Original-PDF offnen

Stapelnamen mit
aktuellen Mandanten
benennen

Kontierungstabelle
einblenden

Dokument sichern

Tabelle loschen und
mit Nettobetragen
vorbelegen

Feldinhalt
runterkopieren

Kontierungszeile
hinzufiigen

Suchen [ Ersetzen in
Spalte

€ ecm:one:

Train field

Train field (alternative
mode)

Remove training ’

Clear all trainings
Train dactylogram
Count dactylograms
Delete dactylograms

Reload all trained
fields

Reload currently
trained fields

Reload changed
training since batch

Reload changed
training since last
verify

14



Webverify

Editing options via the Verify menu

Job

TR Commit job

Qo Cancel job
Separation »

Navigation »

View »

Extras »

Clearing »
Tabellenfunktionen »

Help »

File » Re-create document
AT result
Delete document
- Restore document
Separation »

p—— Validate document
Navigation »

Delete page

View » Restore page
Extras »
Clearing »

Tabellenfunktionen »

Help »

File »
Edit »

Document »

Navigation »

View »
Extras »
Clearing »
Tabellenfunktionen ~
Help »

File »

Edit »

Document »

Separation »

Navigation ~
View »
Clearing »

Tabellenfunktionen -

Help »

Merge with next
document

Merge with previous
document

Split at this page
Move page

Mark remaining pages
as attachment

Functions »

Workflow »

Training »

Clearing »

Finishing »

Stapel an Cutter
schicken
Kontierungsart dndern
Zeige fehlerhafte
Felder

Dublette vorhanden
Bestellung offnen
EMail o6ffnen
Original-PDF offnen
Stapelnamen mit

aktuellen Mandanten
benennen

Kontierungstabelle
einblenden

Dokument sichern

Tabelle I6schen und
mit Nettobetragen
vorbelegen

Feldinhalt
runterkopieren

Kontierungszeile
hinzufiigen

Suchen / Ersetzen in
Spalte

€ ecm:one:

The menu can be opened in the top left-hand corner via the main menu. Further
functions can be found here.

1. file: The job can be sent to any location and canceled.

2. edit: Insert/delete table rows in the split booking.

3. document: Documents or individual pages can be deleted and restored.

4. split: This can be used to merge or split documents (if documents were combined in
the scan)

5. navigation: takes over the shortcuts to move forward on the document.

Extras:

Training: Field training as described above and option to delete training
(dactylogram)Send batch to cutter: Deleted documents/pages are sent and thus
permanently deleted, remaining documents remain in the batch and can be processed
further by reopening the batch.Split booking: Shortcuts are explained and can be
triggered manually from here.

15



Webverify

Use case: New supplier is created during document recognition.

To do this, proceed as follows:

€ ecm:one:

If the master data is improved during batch processing or a new supplier is created, it
must be sent back to the "Analysis" step so that the new master data can be used for
recognition.

1. open and adjust the master data in the Client configuration menu = Suppliers 2
Add supplier

0 S Ny R =
@ ecm:one:
@
. . . ‘
1. open client configuration > &
(=)
eue editor comment # document # pages actions
—
2. open suppliers
A T — \ WM e M:
T @ecmone: |
@ Company master data [ Mail Import _ = General ledger accounts (#90) = Taxkeys = Workflow & Authorisations  — Other FIBU = 5) ger (#4) = Systeme (#4)
o1l Name 1 T} VATID T} LAND T} Properties
Functions
70002 WirMachenDruck GmbH DE77622500300002102858 DE261317770 DE
ol Name 1 T] IBAN 1) VATID T] LAND T] Properties
Functions,
72184 Fugen Schuize DE40160500003G35000624 DE242016160 DE

supplier

3. create new

16
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Webverify

Use case: New supplier is created during document recognition.

Functions »

Training »

Clearing »

Finishing »

Stapel an Cutter
schicken

Kontierungsart andera

Zeige fehlerhafte
Felder

Dublette vorhanden

Bestellung offnen

EMail offnen

Original-PDF 6ffnen

Stapelnamen mit
aktuellen Mandanten
benennen

Kontierungstabelle
einblenden

Dokument sichern

Tabelle loschen und
mit Nettobetragen
vorbelegen

Feldinhalt
runterkopieren

Kontierungszeile
hinzufugen

Suchen / Ersetzen in
Spalte

Mark this document to
be reanalyzed soon

Mark document to be
sent to supervisor

Comment the
document and send it
to supervisor later

Analyze this batch
again instantly

ABUS | Pfaffenhain Gn
abus.com

4. reanalyze the batch

immediately.

Werkzeuge &
Gewerbegebie

48167 Miinste

Zahlungsbed. _ 1
Indexnr: H

Anlagenart: C
Angebot:

vom:_06.09.2023

Pos Artikel-Nr.

1 ZiLa3e
Profilknaufzylii
Z0lit.1808 6-sti
Achsmaf (aufen/:
Knauf innen:STD-
Zylinderprofil::
Schliisselpragun;
Schliisselanzahl
Schachtel:Schmu¢
Zylinderpragung:
Zertifikat:SKG :
Kupplung:Gefahre
Bohrschutz:erhol

Zwischensumme

Bitte beachten ¢
Beziliglich der sj
unsere aktueller
unseren Unternet
Der Lieferzeitpt

2. reopen Webverify in another tab
3. menu = Extras = Workflow = Reanalyze batch immediately

4. the batch is now sent and the tab can be closed. On the document recognition page,
it is now sent through the analysis again and the new master data is taken into account.

The batch can now be reopened.

17



Webverify

¢ BCm:ones:

Use case: Adjust account assignment type during document recognition

1
Edit »
Document »
Separation »

Navigation »

View »

Extras -

Clearing »
Tabellenfunktionen »

Help »

Functions »
Workflow »
Training »
Clearing »
Finishing »

Stapel an Cutter
schicken

Zeige fehlerhafte
Felder

Dublette vorhanden

Bestellung offnen

EMail offnen

Original-PDF offnen

Stapelnamen mit
aktuellen Mandanten
benennen

Kontierungstabelle
einblenden

Dokument sichern

Tabelle l6schen und
mit Nettobetragen
vorbelegen

Feldinhalt
runterkopieren

Kontierungszeile
hinzufligen

Suchen / Ersetzen in
Spalte

1. change account
assignment type.

During document recognition, you can switch between the account assignment types
"Simple account assignment" and "Account assignment with items". To do this, proceed
as follows:

Menu > Extras = Change account assignment type

Wie wollen Sie die Kontierung im Standard fir den Lieferant 70065 - ABUS Pfaffenhaun GmbH durchfiihren (Aktuell: false)?

[Einiache Kontierung] [Konlierung mit Positionen

Rebuild document result.

Empfehlung: Am Besten nun das Dokumentenergebnis neu erstellen!

The account assignment type has not been changed? Please try to send the document
through the analysis again. To do this, please follow these steps.You must now close the
batch, wait until the analysis has run through, and can then open it again as usual.

18



ecm:one Xtractor

The workflow dashboard provides an overview of the documents in the workflow.

A eomione Xir@etor - Dashboard i 2O M:
I DiEYEIES ®
&

Distribute check release

#receipts: 19 K #receipts: 28 # receipts: 53

final check (ﬁnancN accounting) export due invoices

# receipts: 11 # receipis: 0 # receipts: 0

1 EEre e

Click to go to an overview where
you can see all the documents
that are currently in the
workflow step.

€ ecm:one:

If you have any
questions, the help
page will help you
quickly. A complete
operating manual
can be downloaded
under "Click
instructions".

Reminders can be sent to all
users who have open tasks.

19



ERV-Workflow

The workflow consists of 4 steps. First, the invoice is read and distributed in document recognition so that the posting data can be created directly
afterwards. This is followed by the factual check, release and final Financial accounting check steps. The processing of these steps is explained in the

following slides.

Update Status g

4
Final control
of FI

i R

Start export
interface file

End of export
interface file

;I_/

@& ecm:ones:

20



The first steps in the cloud

Opening the tasks.

The workflow tasks can be
opened via the "Tasks" tile.
This shows how many tasks
are currently unprocessed via
the small number. You are
informed about tasks either via
the start page or by email.

&) ecm:one:

d.velop

My dashboard

Search
Storage : . o

Search in d velop documents

DATEV Unternehmen Online -

: (@) ecm:one ERP documents ' :@ Tasks

: ,@ HR-Management : g7 sign

_ ° b

Ik T Tl o e

. ecm:one Xtr@ctor

3 . ecm:one Hotkey

o Auftragsakten

. @ ecm:one Enterprise Dashboard

: . ecm:one Vertragsmanagement

: E ecm:one Xtr@ctor

: e Shared items

22 SHOW CLASSIC VIEW  + ADD WIDGET

# o8 0 ®

21



Tasks

The task list can be accessed via the dashboard. To do this, click on the "Tasks" tile.

Updating the task
list

€ ecm:one:

Tasks

Q, My tasks
2 Senttome

-
2F. Sentto me and athers

Groups

My tasks
2
= Drag columns here to group the displayed results
1
O Priarity Ssubject
0O 2. Checker
. O 1. Verteilen

s2s  Administrative group fort.. 1

My activities

Administration

v

e Show task list of another u...

Context Due Received ASEKJ nee Sender More info LieferantenName LieferantenNr RECl|I7uH(jSDE(M(j
Digitale Rechnun... - 11:50 AM @ Pia Stroot @ d.velop process [ﬂj ABUS Pfaffenhaun GmbH 70065 38.17
Digitale Rechnun... - 10/30/2023 10:44 P. e Administrative gro... @ d.velop process 0] Diverser Kreditor 79999 1329.05

Jo)
E il
iii
&

RechnungsNr
3789456

R/1093792

All due tasks including the most important
properties are displayed in the list. A grouping
can also be made here, e.g. by vendor.

22



Tasks - Distribute

Workflow

EDITING VIEW

In the Distribute step, the invoice can be redistributed if the initial distribution is incorrect.

Digital invoice processing - Distribute

- Attachment Accounting Rechnungsdaten Workflow-Verlauf

Rechnungsdaten:

Mandant: ecm:one Test
Lieferant: 79999 Diverser Kreditor
Nr. / Datum: R/1093792 / 29.03.2023
Betrag: 1.329,05 EUR

Please distribute the invoice to a factual reviewer

Prifer - Bitte auswahlen

Select the correct
distributor.

If a shortened
workflow is required,
the invoice can be
sent directly to the
"Approve" step or to
the accounting
department.

~

Previous comments
% App Builder Bitte nach Genehmiger 1 noch an
300520230819 Genehmiger 2 schickenl

BIUs E=

Enter your comment here

Comments can be left
for the following
examiners.

€ ecm:one:
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Tasks - Factual examination

After opening a specific task, it can be edited.

My tasks

< Workflow

Workflow step

EDITING VIEW

In step 2, factual

check, the invoice can
either be approved or

sent back to step 1.

\

Digital invoice processing - factual review

- Other checker Attachment Accounting Positions

ecm:one Test

Lieferant: 79999 Diverser Kreditor
Nr. / Datum: R/1093792 / 29.03.2023

Betrag: 1.329,05 EUR

DETAILS

eecmuneé Diverser|

<
u
Previous comments 01
% App Builder Bitte nach Genehmiger 1 noch an
30.05.2023 08:19 Genehmiger 2 schicken!
B IUs E=
Enter your comment here
Sy

Comments can be left
for the following
examiners.

€ ecm:one:
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Tasks - Factual examination

After opening a specific task, it can be edited.

The account assignment already
created can be adjusted in the FIBU

€ ecm:one:

The content can be
edited by clicking in
a field.

Existing lines can be
deleted. Additional
account assignment
lines can be added
(individually or several
at once).

167 Minster Kunden-Nr.123456789

tab.
EDITING VIEW DETAILS PROCESS
0 BCM:0ONEl  ABUS Pfaffenhaun GmbH 3789456 [N T Bl
Digital invoice processing - fac review
L4 VIEW PROPERTIES MNOTES (0) VERSIONS (1) ACTIVITIES >
General Other checker  Attachment - Positions [ ] SELECT A DISPLAY FORMAT = b
o | EEYRILE L ° 8
Netamount T,  Vat Code Tl GIL account 1| il ger TL il g text A
1207 Ploase select s 19055 We v 238 Werk W Ploase seb W Please seboct,s Profinautzyinde:
Net total account: 32.07 - Gross invoice amount: 3817
Security Tech Germany
Rechnung
Nr. 3789456
rkzeuge & mehr! Datum @84.09.2023
werbegebiet 1 Seite: 1 von 2
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Workflow step

In this step, the
invoice can be sent
on for booking if it
is approved. If
there are any
queries, the invoice
can also be sent
back to the
reviewer or to step
1, distribution.

Tasks - Release

After opening a specific task, it can be edited.

EDITING VIEW

yd

It is possible to add further
documents and adjust the

Digital invoice processin
payment

- Other approver  Attachment FIBU Positions

Rechnungsdaten:

Mandant: ecmone Test

Lieferant: 70065 ABUS Pfaffenhaun GmbH
Nr. / Datum: 3789456 /04.00.2023

Betrag: 381TEUR

/_

Release booking /

Financial accounting again.

@ ecm:one:

<

Previous comments.

©
-
(S
o
iii
iii

Zahlungsbed. __ 14 Tage 4% Skonto, 38 Tage netto
Indexnr: H23573/36

Anlagenart: Cod. EinzelschlieBung:1wWP

Angebot:

VIEW

ABUS Pfaffenhaun GmbH 3789456

PROPERTIES

1]
PROCESS
a
cw s ool
NOTES (0) VERSIONS (1) ACTIVITIES >
SELECT A DISPLAY FORMAT =~ ::
= oA v 2 172 @ @ 173%.- H a &
Sequrity Tech Germany
Rechnung
Nr. 3789456
Datum @4.09.2023
Seite: 1 von 2

Werkzeuge & mehr!
Gewerbegebiet 1
48167 Minster

vom: ©04.89.2023

Kunden-Nr.123456789

leee813

Hermann Hofmann
94.089.2023 System:
ups 2

Bestellung:

Kommission:
Versandart:

Pos Artikel-Nr.

HMenge ME VPEPreis/st. Rabatt Netto/St. Gesamt
EUR. EYR

1 ZiL43@
Profilknaufzylinder
Zolit.100@ 6-stift.

EUR
26,99
18,99

1 5t.
1 5t.

26,99
18,99

€ ecm:one:
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€ ecm:one:

Tasks - Booking

After opening a specific task, it can be edited.

If the document is not to be posted, the
Workflow step workflow can be ended under Redirect
without the posting data being created.

= ¢ Workflo & o @
My tasks [0}
@ QUCheCKe' s EDRUNG VIEW DETALLS PROCESS
4. Finale Kontrolle FIBU \
g 1zz2em @ecm one;  ABUS Piaffenhaun GmbH 3789456 c % 380
. Digital invgice processing - Accounting
In thls step the control < VIEW PROPERTIES NOTES (0) VERSIONS (1) ACTIVITIES >
I -
bOOklng data can be " [§ SsELECT ADISPLAY FORMAT - m
- . - Redirect Attachment FIBU Rechnungsdaten Workflow-Verlauf _ -
provided and queries — = Aoavx sz - H el
can be sent to the The invoice has been checked and approved Previous comments BT 2 & 00~ 006 & e B
re | ea Se r \ Rechnungsdaten: : 9
Mandant: ecm:one Test
Lieferant: 70085 ABUS Pfaffenhaun GmbH
Nr. / Datum: 3789456 / 04.09.2023
Betrag: 38,17 EUR Security Tech Germany
B IUSsS = Rechnung
T T Nr. 3789456
Werkzeuge & mehr! Datum 04.09.2023
_ 48167 Minster Kunden-Nr.123456789
Zahlungsbed. 14_Tage 4% Skonto, 3@ Tage netto
Indexnr: H23573/36 Bestellung: 1000013
Anlagenart: Cod. EinzelschlieBung:1WP Hermann Hofmann
Angebot: Kommission: 04.09.2023 System:
Versandart: UPS 2
vom:_04.09.2023
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. . € ecm:one:
Administer task list

To take tasks from other users, they can be forwarded via the administrative task list.

= Admi
Tasks + NE
O Mytasks 1 -
= Senttome 0
O P
&, Sent to me and others 0 O
Groups ~ 1 open
s%» Administrative group fort.. 1 Adm_mIStratlon in
the list.
My activities Administrative group for the ter

Administration

) show task list of anather u...

2. enter and select
the user whose
tasks you want to
see.

Please select the user whose tasks you want to view.

Task list of:
daniela

Users

a Daniela Odinius

28



Tasks

of Daniela Odinius
Q, My tasks
2 senttome

2%, Sentto me and others

Groups

s%s  Administrative group fort.. 1

+2» Buchhaltung

4, forward and
select the
corresponding
user.

Administer task list

To take tasks from other users, they can be forwarded via the administrative task list.

5. exit the administrator
view.

My tasks
REFRESH h f
15 @ You are in the administrative view. You see the task list of: Daniela Odinius
. ‘ EXIT ADMINISTRATIVE VIEW
0
* D PI’iOI’Il"{ SlIDJECf M Context Due Received ASSIQIIQE Sender More info LieferantenName LieferantenNr Reclmungﬁbetrag
|:| 1. Frist priifen Digitale Vertrags... 07/31/2023 1200 A..  07/24/2023 09:41 A @ Buchhaltung @ d.velop process ¢ [I]J
., O 1. Frist priifen Digitale Vertrags.. ~ 08/01/2023 1200 A 07/25/202310.28A.. () Buchhaliung (&) dvelop process ¢0
|:| 1. Frist priifen Digitale Vertrags... 10/30/2023 1200 A..  10/23/2023 09:21 P... 9 Buchhaltung @ d.velop process {0
|:| 1. Frist fftfen Digitale Vertrags... 10/31/2023 1200 A..  10/24/2023 09:21 P... a Buchhaltung @ d.velop process ¢ [I]J
0O 1. Frist pfiifen Digitale Vertrags.. ~ 11/01/2023 1200 A 10/25/202300:22P.. () Buchhaltung @) d.velop process e0
3. select task.
= & 1. Frist priifen 2 O
Tasks of Daniela Odinius = 4 ForwarD 1] Details: 000082 Tauschrad GmbH Mietrad
1. Frist prifen Details: 000082 Tauschrad GmbH Mietrad
@0 07/2ss @ 10/23/2023 09:21 PM
—Tten From d velop process 000082 Tauschrad GmbH Mietrad (SR g
[ 40 07/25/2023
- < VIEW PROPERTIES NOTES (0) VERSIONS (1) ACTIVITIES
1. Frist prifen ~  Common properties
G []J 10/23/2023 n ﬁ SELECT A DISPLAY FORMAT ~
1. Frist prifen Context Priority Due - . .
e 10/24/2023 Digitale Vertragspriifung Default 10/30/2023 12:00 AM g o= 124% = Q
1. Frist priifen Reminder i
P /2512025 i AbonnamentVertragT uschradGmbH und Karla Kolumna
0 Tauschrad "
abgeschiossen.
@ 1[ Vertellen . Recipients
Y enrEns @ Buchhaltung Seteiigts Partsion:
3. Freigabe Name Tauschrad GmbH Narne Karla Kolumna
U] 06/23/2023 Adresss Tauschrad StraBe 1 Geburtsdatum
- Adresse
3. Freigabe A i Bngetragen im nd
@ 1] 07/25/2023 History ondevgeres o
Main unter Email-Addresse
3. Freigabe Time Users Event Recipients Details Email Zahlungsmethode. ‘SepaDireciDetit
@ [0} 00/07/2023 e ToLSIRa gurerrt ot o st
10/23/2023 0921 PM ) d.velop process Task created @ Buchhaltung

& 4. Finale Kontrolle FIBU
*9 .

folgendes wird verinbart:

€ ecm:one:

RechnungsNr

A

B
&

L 8w
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€ ecm:one:

Tip - Workflow protocol

If you want to find out about the workflow process so far in order to understand when, where and by whom the task
was processed, take a look at the workflow log.

Workflow

EDITING VIEW DETAI

Digital invoice processing - Distribute @ ecm-one:

- Attachment Accounting Rechnungsdaten Workflow-Verlauf

Rechnungsdaten: Previous comments
Mandant: ecm:one Test o i
# App Builder Bitte nach Genehmiger 1 noch an
Lieferant: 79999 Diverser Kreditor 300520230819 Genehmiger 2 schickenl
Nr. / Datum: R/M093792 / 29.03.2023
Betrag: 1.329,05 EUR
Please distribute the invoice to a factual reviewer

Priifer - Bitte auswahlen v

1 .
¥ .
H E

_ —
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€ ecm:one:

Tip - Workflow protocol

The log opens in the "General" tab on the right-hand side. To view the log, switch to Workflow overview.

Switch to the workflow overview.

Workflow

EDITING VIEW DE' The title, editor, time of editing and

duration are displayed for each step.
Digital invoice processing - Distribute

Allgemein  Attachment Accounting Rechnungsdaten _

Digitale Rechnungsverarbeitung: L700003319

@ ecm:one:

® Process started

05/23/2023 10:28:42 AM

Task completed: 2. Checker

05/30/2023 08:19:05 AM Tlmellne

Task completed: 3. Freigabe
5/30/2023 03:29:20 P\

05/30/2023 03:29:29 PM

Task completed: 4. Finale Kontrolle FIBU

10/30/2023 09:01:48 PM

© 6 0

Task open: 1. Verteilen

°
- 10/30/2023 10:44:23 PM
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Have fun with your new DMS
wishes the

% ecm:one:

The contents have been created according to the current planning and development status and may change at any time. In particular,
time specifications refer to current planning, requirements and resource availability.
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